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Adafruit HUZZAH ESP8266 (ESP-12)

TODO: add notes




ESPresso Lite 1.0

ESPresso Lite 1.0 (beta version) is an Arduino-compatible Wi-Fi development board powered by Espressif System’s own ESP8266 WROOM-02 module. It has breadboard-friendly breakout pins with in-built LED, two reset/flash buttons and a user programmable button . The operating voltage is 3.3VDC, regulated with 800mA maximum current. Special distinctive features include on-board I2C pads that allow direct connection to OLED LCD and sensor boards.




ESPresso Lite 2.0

ESPresso Lite 2.0 is an Arduino-compatible Wi-Fi development board based on an earlier V1 (beta version). Re-designed together with Cytron Technologies, the newly-revised ESPresso Lite V2.0 features the auto-load/auto-program function, eliminating the previous need to reset the board manually before flashing a new program. It also feature two user programmable side buttons and a reset button. The special distinctive features of on-board pads for I2C sensor and actuator is retained.




NodeMCU 0.9


Pin mapping

Pin numbers written on the board itself do not correspond to ESP8266 GPIO pin numbers. Constants are defined to make using this board easier:

static const uint8_t D0   = 16;
static const uint8_t D1   = 5;
static const uint8_t D2   = 4;
static const uint8_t D3   = 0;
static const uint8_t D4   = 2;
static const uint8_t D5   = 14;
static const uint8_t D6   = 12;
static const uint8_t D7   = 13;
static const uint8_t D8   = 15;
static const uint8_t D9   = 3;
static const uint8_t D10  = 1;





If you want to use NodeMCU pin 5, use D5 for pin number, and it will be translated to ‘real’ GPIO pin 14.






NodeMCU 1.0

This module is sold under many names for around $6.50 on AliExpress and it’s one of the cheapest, fully integrated ESP8266 solutions.

It’s an open hardware design with an ESP-12E core and 4 MB of SPI flash.

Acording to the manufacturer, “with a micro USB cable, you can connect NodeMCU devkit to your laptop and flash it without any trouble”. This is more or less true: the board comes with a CP2102 onboard USB to serial adapter which just works, well, the majority of the time. Sometimes flashing fails and you have to reset the board by holding down FLASH + RST, then releasing FLASH, then releasing RST. This forces the CP2102 device to power cycle and to be re-numbered by Linux.

The board also features a NCP1117 voltage regulator, a blue LED on GPIO16 and a 220k/100k Ohm voltage divider on the ADC input pin.

Full pinout and PDF schematics can be found here [https://github.com/nodemcu/nodemcu-devkit-v1.0]




Olimex MOD-WIFI-ESP8266-DEV

This board comes with 2 MB of SPI flash and optional accessories (e.g. evaluation board ESP8266-EVB or BAT-BOX for batteries).

The basic module has three solder jumpers that allow you to switch the operating mode between SDIO, UART and FLASH.

The board is shipped for FLASH operation mode, with jumpers TD0JP=0, IO0JP=1, IO2JP=1.

Since jumper IO0JP is tied to GPIO0, which is PIN 21, you’ll have to ground it before programming with a USB to serial adapter and reset the board by power cycling it.

UART pins for programming and serial I/O are GPIO1 (TXD, pin 3) and GPIO3 (RXD, pin 4).

You can find the board schematics here [https://github.com/OLIMEX/ESP8266/blob/master/HARDWARE/MOD-WIFI-ESP8266-DEV/MOD-WIFI-ESP8266-DEV_schematic.pdf]




Olimex MOD-WIFI-ESP8266

This is a stripped down version of the above. Behaves identically in terms of jumpers but has less pins readily available for I/O. Still 2 MB of SPI flash.




Olimex ESP8266-EVB

It’s a Olimex MOD-WIFI-ESP8266-DEV module installed on the headers of a development board which features some breakout connectors, a button (GPIO0) and a relay (GPIO5).

Programming is pretty straightforward: the board is supported in the Arduino IDE after installing it via the Board Manager [https://github.com/esp8266/Arduino#installing-with-boards-manager]. To download a program you just have to connect GND/RX/TX from a serial/USB adapter to the UEXT connector and press the only button before applying power to enter UART mode.

Don’t connect 5V from the serial/USB adapter to the board or you won’t be able to power cycle it for UART mode.

You can find the board schematics here [https://github.com/OLIMEX/ESP8266/blob/master/HARDWARE/ESP8266-EVB/ESP8266-EVB_Rev_A.pdf].

This guide [https://www.olimex.com/Products/IoT/ESP8266-EVB/resources/ESP8266-EVB-how-to-use-Arduino.pdf] is also useful for the first setup, since it contains the UEXT connector pinout.

Board variants include:


	ESP8266-EVB-BAT: comes with built-in LiPo charger and step-up converter


	ESP8266-EVB-BAT-BOX: as above, but enclosd in a plastic box (non-weatherproof)







SparkFun ESP8266 Thing

Product page: https://www.sparkfun.com/products/13231

TODO: add notes




SweetPea ESP-210

TODO: add notes




ESPino

ESPino integrates the ESP-12 module with a 3.3v regulator, CP2104 USB-Serial bridge and a micro USB connector for easy programming. It is designed for fitting in a breadboard and has an RGB Led and two buttons for easy prototyping.

For more information about the hardware, pinout diagram and programming procedures, please see the datasheet [https://github.com/makerlabmx/ESPino-tools/raw/master/Docs/ESPino-Datasheet-EN.pdf].

Product page: http://www.espino.io/en




WifInfo

WifInfo integrates the ESP-12 or ESP-07+Ext antenna module with a 3.3v regulator and the hardware to be able to measure French telemetry issue from ERDF powering meter serial output. It has a USB connector for powering, an RGB WS2812 Led, 4 pins I2C connector to fit OLED or sensor, and two buttons + FTDI connector and auto reset feature.

For more information, please see WifInfo related blog [http://hallard.me/category/wifinfo/] entries, github [https://github.com/hallard/WifInfo] and community [https://community.hallard.me/category/16/wifinfo] forum.




Generic ESP8266 modules

These modules come in different form factors and pinouts. See the page at ESP8266 community wiki for more info:
ESP8266 Module Family [http://www.esp8266.com/wiki/doku.php?id=esp8266-module-family].

Usually these modules have no bootstapping resistors on board, insufficient decoupling capacitors, no voltage regulator, no reset circuit, and no USB-serial adapter. This makes using them somewhat tricky, compared to development boards which add these features.

In order to use these modules, make sure to observe the following:


	Provide sufficient power to the module. For stable use of the ESP8266 a power supply with 3.3V and >= 250mA is required. Using the power available from USB to Serial adapter is not recommended, these adapters typically do not supply enough current to run ESP8266 reliably in every situation. An external supply or regulator along with filtering capacitors is preferred.


	Connect bootstapping resistors to GPIO0, GPIO2, GPIO15 according to the schematics below.


	Put ESP8266 into bootloader mode before uploading code.







Serial Adapter

There are many different USB to Serial adapters / boards.
To be able to put ESP8266 into bootloader mode using serial handshaking lines, you need the adapter which breaks out RTS and DTR outputs. CTS and DSR are not useful for upload (they are inputs). Make sure the adapter can work with 3.3V IO voltage: it should have a jumper or a switch to select between 5V and 3.3V, or be marked as 3.3V only.

Adapters based around the following ICs should work:


	FT232RL


	CP2102


	CH340G




PL2303-based adapters are known not to work on Mac OS X. See https://github.com/igrr/esptool-ck/issues/9 for more info.




Minimal Hardware Setup for Bootloading and Usage

| PIN           | Resistor | Serial Adapter |
| ————- | ——– | ————– |
| VCC           |          | VCC (3.3V)     |
| GND           |          | GND            |
| TX or GPIO2*  |          | RX             |
| RX            |          | TX             |
| GPIO0         | PullUp   | DTR            |
| Reset*        | PullUp   | RTS            |
| GPIO15*       | PullDown |                |
| CH_PD         | PullUp   |                |


	Note





	GPIO15 is also named MTDO


	Reset is also named RSBT or REST (adding PullUp improves the stability of the module)


	GPIO2 is alternative TX for the boot loader mode


	Directly connecting a pin to VCC or GND is not a substitute for a PullUp or PullDown resistor, doing this can break upload management and the serial console, instability has also been noted in some cases.







ESP to Serial

[image: _images/ESP_to_serial.png]ESP to Serial


Minimal Hardware Setup for Bootloading only

ESPxx Hardware

| PIN           | Resistor | Serial Adapter  |
| ————- | ——– | ————— |
| VCC           |          | VCC (3.3V)      |
| GND           |          | GND             |
| TX or GPIO2   |          | RX              |
| RX            |          | TX              |
| GPIO0         |          | GND             |
| Reset         |          | RTS*            |
| GPIO15        | PullDown |                 |
| CH_PD         | PullUp   |                 |


	Note


	if no RTS is used a manual power toggle is needed











Minimal Hardware Setup for Running only

ESPxx Hardware

| PIN           | Resistor | Power supply    |
| ————- | ——– | ————— |
| VCC           |          | VCC (3.3V)      |
| GND           |          | GND             |
| GPIO0         | PullUp   |                 |
| GPIO15        | PullDown |                 |
| CH_PD         | PullUp   |                 |






Minimal

[image: _images/ESP_min.png]ESP min




Improved Stability

[image: _images/ESP_improved_stability.png]ESP improved stability




Boot Messages and Modes

The ESP module checks at every boot the Pins 0, 2 and 15.
based on them its boots in different modes:

| GPIO15 | GPIO0 | GPIO2 | Mode                             |
| —— | —– | —– | ——————————– |
| 0V     | 0V    | 3.3V  | Uart Bootloader                  |
| 0V     | 3.3V  | 3.3V  | Boot sketch (SPI flash)          |
| 3.3V   | x     | x     | SDIO mode (not used for Arduino) |

at startup the ESP prints out the current boot mode example:

rst cause:2, boot mode:(3,6)





note:


	GPIO2 is used as TX output and the internal Pullup is enabled on boot.





rst cause

| Number | Description            |
| —— | ———————- |
| 0      | unknown                |
| 1      | normal boot            |
| 2      | reset pin              |
| 3      | software reset         |
| 4      | watchdog reset         |




boot mode

the first value respects the pin setup of the Pins 0, 2 and 15.

| Number | GPIO15 | GPIO0 | GPIO2 | Mode       |
| —— | —— | —– | —– | ———- |
| 0      | 0V     | 0V    | 0V    | Not valid  |
| 1      | 0V     | 0V    | 3.3V  | Uart       |
| 2      | 0V     | 3.3V  | 0V    | Not valid  |
| 3      | 0V     | 3.3V  | 3.3V  | Flash      |
| 4      | 3.3V   | 0V    | 0V    | SDIO       |
| 5      | 3.3V   | 0V    | 3.3V  | SDIO       |
| 6      | 3.3V   | 3.3V  | 0V    | SDIO       |
| 7      | 3.3V   | 3.3V  | 3.3V  | SDIO       |

note:


	number = ((GPIO15 << 2) | (GPIO0 << 1) | GPIO2);









WeMos D1

Product page: http://wemos.cc




WeMos D1 mini

Product page: http://wemos.cc




ESPino (WROOM-02 Module) by ThaiEasyElec

ESPino by ThaiEasyElec using WROOM-02 module from Espressif Systems with 4 MB Flash.

We will update an English description soon.


	Product page: http://thaieasyelec.com/products/wireless-modules/wifi-modules/espino-wifi-development-board-detail.html


	Schematics: www.thaieasyelec.com/downloads/ETEE052/ETEE052_ESPino_Schematic.pdf


	Dimensions: http://thaieasyelec.com/downloads/ETEE052/ETEE052_ESPino_Dimension.pdf


	Pinouts: http://thaieasyelec.com/downloads/ETEE052/ETEE052_ESPino_User_Manual_TH_v1_0_20160204.pdf (Please see pg. 8)








          

      

      

    

  

    
      
          
            
  


title: Change Log




Current version


Core


	Leverage realloc() in String::changeBuffer()


	Clean up core files


	Add host side tests


	Fix possible null pointer in umm_malloc


	Remove “Upload Using” option from Tools menu


	Move attachInterrupt and detachInterrupt into IRAM (#1734)


	Implement strstr_P


	Allow indefinite duration for tone()


	Fix crashes when using tone()


	Fix RF_MODE and ADC_MODE


	Move micros, delayMicroseconds, millis to IRAM (#1326)


	Fix pulseIn (#1072, #1149)


	Accept both named constant and ADC channel number in analogRead (#1766)


	Enable heap poisoning only when debug options are enabled (#1800)


	Bootloader: don’t touch RTC memory if it doesn’t contain a valid command (#619)


	Update SDK to 1.5.2 (#1653)


	Clean up variants, fix digitalPinHasPWM definition (#1831)


	Don’t set RF mode on boot unless it was overridden


	Change build.board property for boards which renumber pins like NodeMCU (#1878)


	Fix Exception 2 when using printf or vprintf


	Add ARM tools (#269)







Libraries


	Update axTLS to 5b4be7d


	WiFiClientSecure: implement connection timeout, fix connected method behavior


	WiFiClient: fix write behavior when connection is closed by remote side


	ESP8266HTTPServer: add font MIME types, fix #1601


	ESP8266mDNS: add client support


	Update SPIFFS to 82aeac6


	Servo: move some functions into IRAM (#1742)


	Update SoftwareSerial to version 3.1.0


	ESP8266SSDP: change templates to include deviceType


	ESP8266WebServer: handle more file types


	SPI: add CPOL setting


	ESP8266WebServer: Fix buffer overflow in ESP8266WebServer::authenticate (#1790)


	ESP8266WiFi: fix undefined behavior in WiFiServer::setNoDelay (#1695)


	Servo: use peripheral clock frequency when calculating FRC1 tick count (#1789)


	ESP8266WiFi: avoid multiple instances of INADDR_NONE


	Add LwIP binary built with gcc


	ESP8266WiFi: Allow PSK instead of passphrase in WiFiSTA::begin


	SPI: Fix SPI.transfer16() using wrong endianness


	HTTPClient: decouple transport layer handling + save some RAM


	ESP8266httpUpdate: decouple HTTPS overloads + save some RAM


	Update and move lwIP headers, add options to use different lwIP build


	ESP8266WebServer: wait for data to arrive


	ESP8266WebServer: save RAM by moving response strings to flash (#1732)


	SPI: Speed up SPI.writePattern()







Tools








2.1.0

February 27, 2016

Package link: http://arduino.esp8266.com/versions/2.1.0/package_esp8266com_index.json.


Core


	Add function to know last reset reason.


	Allow control of enabling debug and debug level from IDE


	Add espduino board


	Rework StreamString::write to use String internal buffer directly (#1289)


	Add function to measure stack high water mark


	Fix RAM corruption caused by our hook of register_chipv6_phy(init_data*).


	Optimize PWM interrupt handler for better precision


	Add warning levels configurable through Preferences


	SPIFFS: check if path length is valid (#1089)


	Set CPU frequency before running setup


	Add core_esp8266_features.h to be able to detect the features and libraries included in the ESP core


	Add ESPino to supported boards


	Fix pwm first step getting skipped


	Update SDK to 1.5.1_16_01_08


	Bufferless and interruptless HardwareSerial


	HardwareSerial: allow mapping of UART0 TX to GPIO2


	Add 128K SPIFFS for 512KB modules


	Reduce stack usage by Print::printf


	Fix a crash in String::changeBuffer()


	Implement static initialization guards (#500)


	Implementation of Tone API using timer1


	Use umm_malloc for heap management


	Configurable I2C clock stretching limit


	Add a new board entry for the SparkFun Thing Dev







Libraries


	ESP8266HTTPClient: add CHUNKED encoding support (#1324)


	Fixed crash bug with mDNS where a string buffer could be used uninitialized


	Add WiFi TX power control


	Add WiFi sleep management


	Allow to hook into WiFi events from sketch


	Allow setting TCP timeout


	Add setSleepMode + getSleepMode and setPhyMode + getPhyMode to WiFi


	Update GDBStub library with the source of esp-gdbstub


	Servo: fix detach and attach


	ESP8266mDNS: refactoring, add TXT support


	Add HTTP Basic Auth to WebServer and libb64 (base64) to core


	Fix link-time dependency of ESP8266WebServer on SPIFFS (#862)


	Allow setting client side TLS key and certificate


	Replace chain of UDP pbufs with a single pbuf before sending (#1009)


	Unique Built-In libraries library.properties name


	Improvements for MD5Builder with Stream


	ESP8266SSDP: fixing TTL to 2 per spec


	ESP8266WebServer: a content length of zero should also be sent


	Use SoftwareSerial version 2.2


	EEPROM: optimised _dirty flag


	ESP8266mDNS: advertise all hosted services


	Remove bundled OneWire - ESP8266 support has been merged in the official OneWire sources


	WiFiClientSecure: don’t panic if memory allocation fails


	Verify domain name in WiFiClientSecure::verify


	Speed up WiFi.hostByName when the hostname is actually an IP


	Fix WiFi scan issue (#1355)


	Workaround for LwIP not handling ERR_ABRT


	Servo value read and write fixes







Tools


	espota.py: add support for manually selecting ip and port for host side


	Update esptool to 0.4.8


	Make espota compatible with python 3.5











2.0.0

November 30, 2015

Package link: http://arduino.esp8266.com/versions/2.0.0/package_esp8266com_index.json.


Core


	Add file system APIs and documentation


	Add ConfigFile example


	Allow user to run code in user_rf_pre_init


	Add strtoul and strtol, fix strtod


	Update documentation for NodeMCU and Olimex boards


	Disable interrupts inside ESP.getVcc (#567)


	Erase RTC RAM only if RF mode looks invalid (#619)


	Get pin levels at time of interrupt, rather than the time of calling the handler.


	Move interrupt handlers to ram.


	Improve debug output on critical errors


	Add ArduinoOTA library and docs


	Add WeMos D1 & D1 mini boards


	Add documentation about boot messages and mode meaning


	Disable sleep mode before doing OTA (#1005)


	Add the ability to be called back when the device is about to reset


	Add “Reset Method” menu


	Add MD5 to core


	I2C: generate STOP in case of NACK (fix #698, #254)


	Add libc time functions


	Fix linker script for 512k(no SPIFFS) variant (#966)


	I2S optimizations


	Support Sketch > Export compiled binary


	Update SPIFFS wrapper for 0.3.3


	Fix placement of code into RAM, enable gc-sections


	Make soft wdt reset more obvious


	Force disable IOSWAP for UART0 in HardwareSerial initialization (#744)


	Add IPAddress::toString()







Libraries


	ESP8266WebServer: support for sending of PROGMEM strings


	ESP8266WebServer: support for serving files from file system


	ESP8266WiFi: fix mode selection (#529)


	ESP8266mDNS: allow to work on SoftAP interface


	EEPROM: round requested size to 4 bytes (#659)


	Add ESP8266AVRISP library


	Add ESP8266HTTPUpdate library


	Add HTTPClient library


	Add WiFiClientSecure


	ESP8266WiFi library: add persistent option, fix #1054


	Make RequestHandler handle uploads


	Add Digest Authentication to OTA and espota.py


	Don’t close UDP pcbs when WiFi connection drops (#969)


	Add espsoftwareserial library


	Add HTTP Updater library


	Add Ethernet library for W5100


	Add SPIFFS WebServer Example


	add dnsIP() to ESP8266WiFi class


	OTA support encapsulated to ArduinoOTA class


	Add gdb stub library


	Extracted the WebUpdate example into a library.


	Fix to Servo allowing write() to be called before attach()


	ESP8266WiFi: add function begin without any parameters and add psk function to return current PSK form sdk config


	Fix a crash due to abort() called from TCP error callback (#428)


	Adding support for OPTIONS requests to ESP8266WebServer


	Add HTTPS request sample (#43)


	Fix _useClientMode & _useApMode in SDK auto connect mode (#754)


	Add ESP8266WebServer::sendContent_P with ‘size_t size’ argument for binary content


	Fix bug in WiFiClient::write_P when content was binary


	Add WiFiClient::write_P to be used with PROGMEM







Tools


	Update SDK to 1.3.0_15_08_10_p1


	Update esptool to 0.4.6


	Bump toolchain version to force libm update on Windows


	ESP8266FS tool update











1.6.5-947-g39819f0

July 23, 2015

Package link: http://arduino.esp8266.com/versions/1.6.5-947-g39819f0/package_esp8266com_index.json.


Core


	I2C library updated to better handle repeated start for certain devices,
improved waveforms, higher frequencies for 160MHz core clock, fix case where
using different pins would not work with libs calling begin internally.


	Add Adafruit HUZZAH board


	Add SparkFun Thing board


	Add SweetPea ESP-210 board


	Add eboot bootloader


	Timer0 support


	Add PWM range and frequency control


	Add ESP.eraseConfig method


	Fix pin change interrupt handling (#322)


	Add SLC and I2S register definitions


	Fix math functions calling themselves recursively (#233, #354)


	Print stack on exception and soft WDT reset


	Add Updater class


	Remove implementations of WDT-related functions


	Provide selection between A0 and VCC (#443, #338)







Libraries


	ESP8266WebServer: add gzip streaming, fix sendContent behaviour,
add setContentSize method.


	ESP8266WiFi: add BSSID, channel, isHidden methods, fix AP/STA mode
selection (#28).


	Better handling of WiFi disconnect (#231)


	Add API to set the beginning of local ports range for WiFiClient.


	Add RSSI function


	Add function to get the MAC / BSSID as String


	Servo library support


	Add ESP8266WiFiMesh library


	Add ESP8266SSDP library


	Add DNS-SD support to ESP8266mDNS library







Tools


	Update SDK to v1.2.0_15_07_03


	Better sketch size reporting (#314)


	Update esptool to 0.4.5











1.6.4-673-g8cd3697

May 22, 2015

Package link: http://arduino.esp8266.com/versions/1.6.4-673-g8cd3697/package_esp8266com_index.json.


Tools


	Add 32-bit Linux toolchain.


	Rebuild toolchain and esptool with support for OS X down to 10.6.







Libraries


	Better connection handling in ESP8266WebServer.
The server now sends Content-Length and Connection: close headers,
then waits for the client to disconnect. By not closing the connection
actively, server avoids TIME_WAIT TCP state, and TCP stack is able to
release the memory immediately, without waiting for 2xMSL period.
If the client doesn’t disconnect in 2000ms, the server closes the connection
actively.


	Add Hash library, which has a function to calculate SHA1 hash.


	SD, Adafruit_ILI9341, and OneWire libraries are now bundled.


	Fix incorrect sector calculation in EEPROM library.











1.6.4-628-g545ffde

May 19, 2015


	Initial release of Boards Manager package for ESP8266 platform.








          

      

      

    

  

    
      
          
            
  
Exception Causes (EXCCAUSE)

| EXC-CAUSE Code | Cause Name                 | Cause Description                                                                                           | Required Option          | EXC-VADDR Loaded |
|:————–:|:—————————|:————————————————————————————————————|:————————-|:—————-:|
| 0              | IllegalInstructionCause    | Illegal instruction                                                                                         | Exception                | No               |
| 1              | SyscallCause               | SYSCALL instruction                                                                                         | Exception                | No               |
| 2              | InstructionFetchErrorCause | Processor internal physical address or data error during instruction fetch                                  | Exception                | Yes              |
| 3              | LoadStoreErrorCause        | Processor internal physical address or data error during load or store                                      | Exception                | Yes              |
| 4              | Level1InterruptCause       | Level-1 interrupt as indicated by set level-1 bits in the INTERRUPT register                                | Interrupt                | No               |
| 5              | AllocaCause                | MOVSP instruction, if caller?s registers are not in the register file                                       | Windowed Register        | No               |
| 6              | IntegerDivideByZeroCause   | QUOS, QUOU, REMS, or REMU divisor operand is zero                                                           | 32-bit Integer Divide    | No               |
| 7              | Reserved for Tensilica     |                                                                                                             |                          |                  |
| 8              | PrivilegedCause            | Attempt to execute a privileged operation when CRING ? 0                                                    | MMU                      | No               |
| 9              | LoadStoreAlignmentCause    | Load or store to an unaligned address                                                                       | Unaligned Exception      | Yes              |
| 10..11         | Reserved for Tensilica     |                                                                                                             |                          |                  |
| 12             | InstrPIFDataErrorCause     | PIF data error during instruction fetch                                                                     | Processor Interface      | Yes              |
| 13             | LoadStorePIFDataErrorCause | Synchronous PIF data error during LoadStore access                                                          | Processor Interface      | Yes              |
| 14             | InstrPIFAddrErrorCause     | PIF address error during instruction fetch                                                                  | Processor Interface      | Yes              |
| 15             | LoadStorePIFAddrErrorCause | Synchronous PIF address error during LoadStore access                                                       | Processor Interface      | Yes              |
| 16             | InstTLBMissCause           | Error during Instruction TLB refill                                                                         | MMU                      | Yes              |
| 17             | InstTLBMultiHitCause       | Multiple instruction TLB entries matched                                                                    | MMU                      | Yes              |
| 18             | InstFetchPrivilegeCause    | An instruction fetch referenced a virtual address at a ring level less than CRING                           | MMU                      | Yes              |
| 19             | Reserved for Tensilica     |                                                                                                             |                          |                  |
| 20             | InstFetchProhibitedCause   | An instruction fetch referenced a page mapped with an attribute that does not permit instruction fetch      | Region Protection or MMU | Yes              |
| 21..23         | Reserved for Tensilica     |                                                                                                             |                          |                  |
| 24             | LoadStoreTLBMissCause      | Error during TLB refill for a load or store                                                                 | MMU                      | Yes              |
| 25             | LoadStoreTLBMultiHitCause  | Multiple TLB entries matched for a load or store                                                            | MMU                      | Yes              |
| 26             | LoadStorePrivilegeCause    | A load or store referenced a virtual address at a ring level less than CRING                                | MMU                      | Yes              |
| 27             | Reserved for Tensilica     |                                                                                                             |                          |                  |
| 28             | LoadProhibitedCause        | A load referenced a page mapped with an attribute that does not permit loads                                | Region Protection or MMU | Yes              |
| 29             | StoreProhibitedCause       | A store referenced a page mapped with an attribute that does not permit stores                              | Region Protection or MMU | Yes              |
| 30..31         | Reserved for Tensilica     |                                                                                                             |                          |                  |
| 32..39         | CoprocessornDisabled       | Coprocessor n instruction when cpn disabled. n varies 0..7 as the cause varies 32..39                       | Coprocessor              | No               |
| 40..63         | Reserved                   |                                                                                                             |                          |                  |

Infos from Xtensa Instruction Set Architecture (ISA) Reference Manual
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Flash layout

Even though file system is stored on the same flash chip as the program, programming new sketch will not modify file system contents. This allows to use file system to store sketch data, configuration files, or content for Web server.

The following diagram illustrates flash layout used in Arduino environment:

|--------------|-------|---------------|--|--|--|--|--|
^              ^       ^               ^     ^
Sketch    OTA update   File system   EEPROM  WiFi config (SDK)





File system size depends on the flash chip size. Depending on the board which is selected in IDE, you have the following options for flash size:

Board | Flash chip size, bytes | File system size, bytes
——|—————–|—————–
Generic module | 512k | 64k, 128k
Generic module | 1M | 64k, 128k, 256k, 512k
Generic module | 2M | 1M
Generic module | 4M | 3M
Adafruit HUZZAH | 4M | 1M, 3M
ESPresso Lite 1.0 | 4M | 1M, 3M
ESPresso Lite 2.0 | 4M | 1M, 3M
NodeMCU 0.9    | 4M | 1M, 3M
NodeMCU 1.0    | 4M | 1M, 3M
Olimex MOD-WIFI-ESP8266(-DEV)| 2M | 1M
SparkFun Thing | 512k | 64k
SweetPea ESP-210 | 4M | 1M, 3M
WeMos D1 & D1 mini | 4M | 1M, 3M
ESPDuino | 4M | 1M, 3M

Note: to use any of file system functions in the sketch, add the following include to the sketch:

#include "FS.h"








Uploading files to file system

ESP8266FS is a tool which integrates into the Arduino IDE. It adds a menu item to Tools menu for uploading the contents of sketch data directory into ESP8266 flash file system.


	Download the tool: https://github.com/esp8266/arduino-esp8266fs-plugin/releases/download/0.2.0/ESP8266FS-0.2.0.zip.


	In your Arduino sketchbook directory, create tools directory if it doesn’t exist yet


	Unpack the tool into tools directory (the path will look like <home_dir>/Arduino/tools/ESP8266FS/tool/esp8266fs.jar)


	Restart Arduino IDE


	Open a sketch (or create a new one and save it)


	Go to sketch directory (choose Sketch > Show Sketch Folder)


	Create a directory named data and any files you want in the file system there


	Make sure you have selected a board, port, and closed Serial Monitor


	Select Tools > ESP8266 Sketch Data Upload. This should start uploading the files into ESP8266 flash file system. When done, IDE status bar will display SPIFFS Image Uploaded message.







File system object (SPIFFS)


begin

SPIFFS.begin()





This method mounts SPIFFS file system. It must be called before any other
FS APIs are used. Returns true if file system was mounted successfully, false
otherwise.




format

SPIFFS.format()





Formats the file system. May be called either before or after calling begin.
Returns true if formatting was successful.




open

SPIFFS.open(path, mode)





Opens a file. path should be an absolute path starting with a slash
(e.g. /dir/filename.txt). mode is a string specifying access mode. It can be
one of “r”, “w”, “a”, “r+”, “w+”, “a+”. Meaning of these modes is the same as
for fopen C function.

   r      Open text file for reading.  The stream is positioned at the
          beginning of the file.

   r+     Open for reading and writing.  The stream is positioned at the
          beginning of the file.

   w      Truncate file to zero length or create text file for writing.
          The stream is positioned at the beginning of the file.

   w+     Open for reading and writing.  The file is created if it does
          not exist, otherwise it is truncated.  The stream is
          positioned at the beginning of the file.

   a      Open for appending (writing at end of file).  The file is
          created if it does not exist.  The stream is positioned at the
          end of the file.

   a+     Open for reading and appending (writing at end of file).  The
          file is created if it does not exist.  The initial file
          position for reading is at the beginning of the file, but
          output is always appended to the end of the file.





Returns File object. To check whether the file was opened successfully, use
the boolean operator.

File f = SPIFFS.open("/f.txt", "w");
if (!f) {
    Serial.println("file open failed");
}








exists

SPIFFS.exists(path)





Returns true if a file with given path exists, false otherwise.




openDir

SPIFFS.openDir(path)





Opens a directory given its absolute path. Returns a Dir object.




remove

SPIFFS.remove(path)





Deletes the file given its absolute path. Returns true if file was deleted successfully.




rename

SPIFFS.rename(pathFrom, pathTo)





Renames file from pathFrom to pathTo. Paths must be absolute. Returns true
if file was renamed successfully.




info

FSInfo fs_info;
SPIFFS.info(fs_info);





Fills FSInfo structure with information about
the file system. Returns true is successful, false otherwise.






Filesystem information structure

struct FSInfo {
    size_t totalBytes;
    size_t usedBytes;
    size_t blockSize;
    size_t pageSize;
    size_t maxOpenFiles;
    size_t maxPathLength;
};





This is the structure which may be filled using FS::info method.


	totalBytes — total size of useful data on the file system


	usedBytes — number of bytes used by files


	blockSize — SPIFFS block size


	pageSize — SPIFFS logical page size


	maxOpenFiles — max number of files which may be open simultaneously


	maxPathLength — max file name length (including one byte for zero termination)







Directory object (Dir)

The purpose of Dir object is to iterate over files inside a directory.
It provides three methods: next(), fileName(), and openFile(mode).

The following example shows how it should be used:

Dir dir = SPIFFS.openDir("/data");
while (dir.next()) {
    Serial.print(dir.fileName());
    File f = dir.openFile("r");
    Serial.println(f.size());
}





dir.next() returns true while there are files in the directory to iterate over.
It must be called before calling fileName and openFile functions.

openFile method takes mode argument which has the same meaning as for SPIFFS.open function.




File object

SPIFFS.open and dir.openFile functions return a File object. This object
supports all the functions of Stream, so you can use readBytes, findUntil,
parseInt, println, and all other Stream methods.

There are also some functions which are specific to File object.


seek

file.seek(offset, mode)





This function behaves like fseek C function. Depending on the value of mode,
it moves current position in a file as follows:


	if mode is SeekSet, position is set to offset bytes from the beginning.


	if mode is SeekCur, current position is moved by offset bytes.


	if mode is SeekEnd, position is set to offset bytes from the end of the
file.




Returns true if position was set successfully.




position

file.position()





Returns the current position inside the file, in bytes.




size

file.size()





Returns file size, in bytes.




name

String name = file.name();





Returns file name, as const char*. Convert it to String for storage.




close

file.close()





Close the file. No other operations should be performed on File object after close function was called.







          

      

      

    

  

    
      
          
            
  


title: Installation




Boards Manager

This is the suggested installation method for end users.


Prerequisites


	Arduino 1.6.8, get it from Arduino website [https://www.arduino.cc/en/Main/OldSoftwareReleases#previous].


	Internet connection







Instructions


	Start Arduino and open Preferences window.


	Enter http://arduino.esp8266.com/stable/package_esp8266com_index.json into Additional Board Manager URLs field. You can add multiple URLs, separating them with commas.


	Open Boards Manager from Tools > Board menu and find esp8266 platform.


	Select the version you need from a drop-down box.


	Click install button.


	Don’t forget to select your ESP8266 board from Tools > Board menu after installation.




You may optionally use staging boards manager package link:
http://arduino.esp8266.com/staging/package_esp8266com_index.json. This may contain some new features, but at the same time, some things might be broken.






Using git version

This is the suggested installation method for contributors and library developers.


Prerequisites


	Arduino 1.6.8 (or newer, if you know what you are doing)


	git


	python 2.7


	terminal, console, or command prompt (depending on you OS)


	Internet connection







Instructions


	Open the console and go to Arduino directory. This can be either your sketchbook directory (usually <Documents>/Arduino), or the directory of Arduino application itself, the choice is up to you.


	Clone this repository into hardware/esp8266com/esp8266 directory. Alternatively, clone it elsewhere and create a symlink, if your OS supports them.

cd hardware
mkdir esp8266com
cd esp8266com
git clone https://github.com/esp8266/Arduino.git esp8266





You should end up with the following directory structure:

Arduino
|
--- hardware
    |
    --- esp8266com
        |
        --- esp8266
            |
            --- bootloaders
            --- cores
            --- doc
            --- libraries
            --- package
            --- tests
            --- tools
            --- variants
            --- platform.txt
            --- programmers.txt
            --- README.md
            --- boards.txt
            --- LICENSE







	Download binary tools

cd esp8266/tools
python get.py







	Restart Arduino
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WiFi(ESP8266WiFi library)

This is mostly similar to WiFi shield library. Differences include:


	WiFi.mode(m): set mode to WIFI_AP, WIFI_STA, WIFI_AP_STA or WIFI_OFF.


	call WiFi.softAP(ssid) to set up an open network


	call WiFi.softAP(ssid, password) to set up a WPA2-PSK network (password should be at least 8 characters)


	WiFi.macAddress(mac) is for STA, WiFi.softAPmacAddress(mac) is for AP.


	WiFi.localIP() is for STA, WiFi.softAPIP() is for AP.


	WiFi.printDiag(Serial) will print out some diagnostic info


	WiFiUDP class supports sending and receiving multicast packets on STA interface.
When sending a multicast packet, replace udp.beginPacket(addr, port) with
udp.beginPacketMulticast(addr, port, WiFi.localIP()).
When listening to multicast packets, replace udp.begin(port) with
udp.beginMulticast(WiFi.localIP(), multicast_ip_addr, port).
You can use udp.destinationIP() to tell whether the packet received was
sent to the multicast or unicast address.




WiFiServer, WiFiClient, and WiFiUDP behave mostly the same way as with WiFi shield library.
Four samples are provided for this library.
You can see more commands here: http://www.arduino.cc/en/Reference/WiFi




Ticker

Library for calling functions repeatedly with a certain period. Two examples included.

It is currently not recommended to do blocking IO operations (network, serial, file) from Ticker
callback functions. Instead, set a flag inside the ticker callback and check for that flag inside the loop function.

Here is library to simplificate Ticker usage and avoid WDT reset: TickerScheduler [https://github.com/Toshik/TickerScheduler]




EEPROM

This is a bit different from standard EEPROM class. You need to call EEPROM.begin(size)
before you start reading or writing, size being the number of bytes you want to use.
Size can be anywhere between 4 and 4096 bytes.

EEPROM.write does not write to flash immediately, instead you must call EEPROM.commit()
whenever you wish to save changes to flash. EEPROM.end() will also commit, and will
release the RAM copy of EEPROM contents.

EEPROM library uses one sector of flash located just after the SPIFFS.

Three examples included.




I2C (Wire library)

Wire library currently supports master mode up to approximately 450KHz.
Before using I2C, pins for SDA and SCL need to be set by calling
Wire.begin(int sda, int scl), i.e. Wire.begin(0, 2) on ESP-01,
else they default to pins 4(SDA) and 5(SCL).




SPI

SPI library supports the entire Arduino SPI API including transactions, including setting phase (CPHA).
Setting the Clock polarity (CPOL) is not supported, yet (SPI_MODE2 and SPI_MODE3 not working).




SoftwareSerial

An ESP8266 port of SoftwareSerial library done by Peter Lerup (@plerup) supports baud rate up to 115200 and multiples SoftwareSerial instances. See https://github.com/plerup/espsoftwareserial if you want to suggest an improvement or open an issue related to SoftwareSerial.




ESP-specific APIs

APIs related to deep sleep and watchdog timer are available in the ESP object, only available in Alpha version.

ESP.deepSleep(microseconds, mode) will put the chip into deep sleep. mode is one of WAKE_RF_DEFAULT, WAKE_RFCAL, WAKE_NO_RFCAL, WAKE_RF_DISABLED. (GPIO16 needs to be tied to RST to wake from deepSleep.)

ESP.restart() restarts the CPU.

ESP.getResetReason() returns String containing the last reset resaon in human readable format.

ESP.getFreeHeap() returns the free heap size.

ESP.getChipId() returns the ESP8266 chip ID as a 32-bit integer.

Several APIs may be used to get flash chip info:

ESP.getFlashChipId() returns the flash chip ID as a 32-bit integer.

ESP.getFlashChipSize() returns the flash chip size, in bytes, as seen by the SDK (may be less than actual size).

ESP.getFlashChipSpeed(void) returns the flash chip frequency, in Hz.

ESP.getCycleCount() returns the cpu instruction cycle count since start as an unsigned 32-bit.  This is useful for accurate timing of very short actions like bit banging.

ESP.getVcc() may be used to measure supply voltage. ESP needs to reconfigure the ADC
at startup in order for this feature to be available. Add the following line to the top
of your sketch to use getVcc:

ADC_MODE(ADC_VCC);





TOUT pin has to be disconnected in this mode.

Note that by default ADC is configured to read from TOUT pin using analogRead(A0), and
ESP.getVCC() is not available.




mDNS and DNS-SD responder (ESP8266mDNS library)

Allows the sketch to respond to multicast DNS queries for domain names like “foo.local”, and DNS-SD (service dicovery) queries.
See attached example for details.




SSDP responder (ESP8266SSDP)

SSDP is another service discovery protocol, supported on Windows out of the box. See attached example for reference.




DNS server (DNSServer library)

Implements a simple DNS server that can be used in both STA and AP modes. The DNS server currently supports only one domain (for all other domains it will reply with NXDOMAIN or custom status code). With it clients can open a web server running on ESP8266 using a domain name, not an IP address.
See attached example for details.




Servo

This library exposes the ability to control RC (hobby) servo motors. It will support upto 24 servos on any available output pin. By defualt the first 12 servos will use Timer0 and currently this will not interfere with any other support.  Servo counts above 12 will use Timer1 and features that use it will be effected.
While many RC servo motors will accept the 3.3V IO data pin from a ESP8266, most will not be able to run off 3.3v and will require another power source that matches their specifications.  Make sure to connect the grounds between the ESP8266 and the servo motor power supply.




Other libraries (not included with the IDE)

Libraries that don’t rely on low-level access to AVR registers should work well. Here are a few libraries that were verified to work:


	Adafruit_ILI9341 [https://github.com/Links2004/Adafruit_ILI9341] - Port of the Adafruit ILI9341 for the ESP8266


	arduinoVNC [https://github.com/Links2004/arduinoVNC] - VNC Client for Arduino


	arduinoWebSockets [https://github.com/Links2004/arduinoWebSockets] - WebSocket Server and Client compatible with ESP8266 (RFC6455)


	aREST [https://github.com/marcoschwartz/aREST] - REST API handler library.


	Blynk [https://github.com/blynkkk/blynk-library] - easy IoT framework for Makers (check out the Kickstarter page [http://tiny.cc/blynk-kick]).


	DallasTemperature [https://github.com/milesburton/Arduino-Temperature-Control-Library.git]


	DHT-sensor-library [https://github.com/adafruit/DHT-sensor-library] - Arduino library for the DHT11/DHT22 temperature and humidity sensors. Download latest v1.1.1 library and no changes are necessary.  Older versions should initialize DHT as follows: DHT dht(DHTPIN, DHTTYPE, 15)


	DimSwitch [https://github.com/krzychb/DimSwitch] - Control electronic dimmable ballasts for fluorescent light tubes remotely as if using a wall switch.


	Encoder [https://github.com/PaulStoffregen/Encoder] - Arduino library for rotary encoders. Version 1.4 supports ESP8266.


	esp8266_mdns [https://github.com/mrdunk/esp8266_mdns] - mDNS queries and responses on esp8266. Or to describe it another way: An mDNS Client or Bonjour Client library for the esp8266.


	ESPAsyncTCP [https://github.com/me-no-dev/ESPAsyncTCP] - Asynchronous TCP Library for ESP8266 and ESP32/31B


	ESPAsyncWebServer [https://github.com/me-no-dev/ESPAsyncWebServer] - Asynchronous Web Server Library for ESP8266 and ESP32/31B


	Homie for ESP8266 [https://github.com/marvinroger/homie-esp8266] - Arduino framework for ESP8266 implementing Homie, an MQTT convention for the IoT.


	NeoPixel [https://github.com/adafruit/Adafruit_NeoPixel] - Adafruit’s NeoPixel library, now with support for the ESP8266 (use version 1.0.2 or higher from Arduino’s library manager).


	NeoPixelBus [https://github.com/Makuna/NeoPixelBus] - Arduino NeoPixel library compatible with ESP8266. Use the “DmaDriven” or “UartDriven” branches for ESP8266. Includes HSL color support and more.


	PubSubClient [https://github.com/Imroy/pubsubclient] - MQTT library by @Imroy.


	RTC [https://github.com/Makuna/Rtc] - Arduino Library for Ds1307 & Ds3231 compatible with ESP8266.


	Souliss, Smart Home [https://github.com/souliss/souliss] - Framework for Smart Home based on Arduino, Android and openHAB.


	ST7735 [https://github.com/nzmichaelh/Adafruit-ST7735-Library] - Adafruit’s ST7735 library modified to be compatible with ESP8266.  Just make sure to modify the pins in the examples as they are still AVR specific.


	Task [https://github.com/Makuna/Task] - Arduino Nonpreemptive multitasking library.  While similiar to the included Ticker library in the functionality provided, this library was meant for cross Arduino compatibility.


	TickerScheduler [https://github.com/Toshik/TickerScheduler] - Library provides simple scheduler for Ticker to avoid WDT reset


	Teleinfo [https://github.com/hallard/LibTeleinfo] - Generic French Power Meter library to read Teleinfo energy monitoring data such as consuption, contract, power, period, … This library is cross platform, ESP8266, Arduino, Particle, and simple C++. French dedicated post [https://hallard.me/libteleinfo/] on author’s blog and all related information about Teleinfo [https://hallard.me/category/tinfo/] also available.


	UTFT-ESP8266 [https://github.com/gnulabis/UTFT-ESP8266] - UTFT display library with support for ESP8266. Only serial interface (SPI) displays are supported for now (no 8-bit parallel mode, etc). Also includes support for the hardware SPI controller of the ESP8266.


	WiFiManager [https://github.com/tzapu/WiFiManager] - WiFi Connection manager with web captive portal. If it can’t connect, it starts AP mode and a configuration portal so you can choose and enter WiFi credentials.


	OneWire [https://github.com/PaulStoffregen/OneWire] - Library for Dallas/Maxim 1-Wire Chips.


	Adafruit-PCD8544-Nokia-5110-LCD-Library [https://github.com/WereCatf/Adafruit-PCD8544-Nokia-5110-LCD-library] - Port of the Adafruit PCD8544 - library for the ESP8266.


	PCF8574_ESP [https://github.com/WereCatf/PCF8574_ESP] - A very simplistic library for using the PCF8574/PCF8574A I2C 8-pin GPIO-expander.


	Dot Matrix Display Library 2 [https://github.com/freetronics/DMD2] - Freetronics DMD & Generic 16 x 32 P10 style Dot Matrix Display Library


	SdFat-beta [https://github.com/greiman/SdFat-beta] - SD-card library with support for long filenames, software- and hardware-based SPI and lots more.


	FastLED [https://github.com/FastLED/FastLED] - a library for easily & efficiently controlling a wide variety of LED chipsets, like the Neopixel (WS2812B), DotStar, LPD8806 and many more. Includes fading, gradient, color conversion functions.


	OLED [https://github.com/klarsys/esp8266-OLED] - a library for controlling I2C connected OLED displays. Tested with 0.96 inch OLED graphics display.
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Digital IO

Pin numbers in Arduino correspond directly to the ESP8266 GPIO pin numbers. pinMode, digitalRead, and digitalWrite functions work as usual, so to read GPIO2, call digitalRead(2).

Digital pins 0—15 can be INPUT, OUTPUT, or INPUT_PULLUP.
Pin 16 can be INPUT, OUTPUT or INPUT_PULLDOWN_16. At startup, pins are configured as INPUT.

Pins may also serve other functions, like Serial, I2C, SPI. These functions are normally activated by the corresponding library. The diagram below shows pin mapping for the popular ESP-12 module.

[image: _images/esp12.png]Pin Functions

Digital pins 6—11 are not shown on this diagram because they are used to connect flash memory chip on most modules. Trying to use these pins as IOs will likely cause the program to crash.

Note that some boards and modules (ESP-12ED, NodeMCU 1.0) also break out pins 9 and 11. These may be used as IO if flash chip works in DIO mode (as opposed to QIO, which is the default one).

Pin interrupts are supported through attachInterrupt, detachInterrupt functions.
Interrupts may be attached to any GPIO pin, except GPIO16. Standard Arduino interrupt
types are supported: CHANGE, RISING, FALLING.




Analog input

ESP8266 has a single ADC channel available to users. It may be used either to read voltage at ADC pin, or to read module supply voltage (VCC).

To read external voltage applied to ADC pin, use analogRead(A0). Input voltage range is 0 — 1.0V.

To read VCC voltage, use ESP.getVcc() and ADC pin must be kept unconnected. Additionally, the following line has to be added to the sketch:

ADC_MODE(ADC_VCC);





This line has to appear outside of any functions, for instance right after the #include lines of your sketch.




Analog output

analogWrite(pin, value) enables software PWM on the given pin. PWM may be used on pins 0 to 16.
Call analogWrite(pin, 0) to disable PWM on the pin. value may be in range from 0 to PWMRANGE, which is equal to 1023 by default. PWM range may be changed by calling analogWriteRange(new_range).

PWM frequency is 1kHz by default. Call analogWriteFreq(new_frequency) to change the frequency.




Timing and delays

millis() and micros() return the number of milliseconds and microseconds elapsed after reset, respectively.

delay(ms) pauses the sketch for a given number of milliseconds and allows WiFi and TCP/IP tasks to run.
delayMicroseconds(us) pauses for a given number of microseconds.

Remember that there is a lot of code that needs to run on the chip besides the sketch
when WiFi is connected. WiFi and TCP/IP libraries get a chance to handle any pending
events each time the loop() function completes, OR when delay is called.
If you have a loop somewhere in your sketch that takes a lot of time (>50ms) without
calling delay, you might consider adding a call to delay function to keep the WiFi
stack running smoothly.

There is also a yield() function which is equivalent to delay(0). The delayMicroseconds
function, on the other hand, does not yield to other tasks, so using it for delays
more than 20 milliseconds is not recommended.




Serial

Serial object works much the same way as on a regular Arduino. Apart from hardware FIFO (128 bytes for TX and RX) HardwareSerial has additional 256-byte TX and RX buffers. Both transmit and receive is interrupt-driven. Write and read functions only block the sketch execution when the respective FIFO/buffers are full/empty.

Serial uses UART0, which is mapped to pins GPIO1 (TX) and GPIO3 (RX). Serial may be remapped to GPIO15 (TX) and GPIO13 (RX) by calling Serial.swap() after Serial.begin. Calling swap again maps UART0 back to GPIO1 and GPIO3.

Serial1 uses UART1, TX pin is GPIO2. UART1 can not be used to receive data because normally it’s RX pin is occupied for flash chip connection. To use Serial1, call Serial1.begin(baudrate).

If Serial1 is not used and Serial is not swapped - TX for UART0 can be mapped to GPIO2 instead by calling Serial.set_tx(2) after Serial.begin or directly with Serial.begin(baud, config, mode, 2).

By default the diagnostic output from WiFi libraries is disabled when you call Serial.begin. To enable debug output again, call Serial.setDebugOutput(true). To redirect debug output to Serial1 instead, call Serial1.setDebugOutput(true).

You also need to use Serial.setDebugOutput(true) to enable output from printf() function.

Both Serial and Serial1 objects support 5, 6, 7, 8 data bits, odd (O), even (E), and no (N) parity, and 1 or 2 stop bits. To set the desired mode, call Serial.begin(baudrate, SERIAL_8N1), Serial.begin(baudrate, SERIAL_6E2), etc.




Progmem

The Program memory features work much the same way as on a regular Arduino; placing read only data and strings in read only memory and freeing heap for your application.
The important difference is that on the ESP8266 the literal strings are not pooled.  This means that the same literal string defined inside a F("") and/or PSTR("") will take up space for each instance in the code. So you will need to manage the duplicate strings yourself.

There is one additional helper macro to make it easier to pass const PROGMEM strings to methods that take a __FlashStringHelper called FPSTR().  The use of this will help make it easier to pool strings.
Not pooling strings…

String response1;
response1 += F("http:");
...
String response2;
response2 += F("http:");





using FPSTR would become…

const char HTTP[] PROGMEM = "http:";
...
{
    String response1;
    response1 += FPSTR(HTTP);
    ...
    String response2;
    response2 += FPSTR(HTTP);
}
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Introduction

Since 2.1.0-rc1 the core includes a Debugging feature that is controllable over the IDE menu.

The new menu points manage the real-time Debug messages.


Requirements

For usage of the debugging a Serial connection is required (Serial or Serial1).

The Serial Interface need to be initialized in the setup().

Set the Serial baud rate as high as possible for your Hardware setup.

Minimum sketch to use debugging:

void setup() {
    Serial.begin(115200);
}

void loop() {
}








Usage


	Select the Serial interface for the Debugging messages:
[image: ../_images/debug_port.png]Debug-Port


	Select which type / level you want debug messages for:
[image: ../_images/debug_level.png]Debug-Level


	Check if the Serial interface is initialized in setup() (see Requirements)


	Flash sketch


	Check the Serial Output









Informations

It work with every sketch that enables the Serial interface that is selected as debug port.

The Serial interface can still be used normal in the Sketch.

The debug output is additional and will not disable any interface from usage in the sketch.


For Developers

For the debug handling uses defines.

The defined are set by command line.


Debug Port

The port has the define DEBUG_ESP_PORT possible value:


	Disabled: 	define not existing


	Serial: 		Serial


	Serial1: 	Serial1







Debug Level

All defines for the different levels starts with DEBUG_ESP_

a full list can be found here in the boards.txt [https://github.com/esp8266/Arduino/blob/master/boards.txt#L180]




Example for own debug messages

The debug messages will be only shown when the Debug Port in the IDE menu is set.

#ifdef DEBUG_ESP_PORT
#define DEBUG_MSG(...) DEBUG_ESP_PORT.printf( __VA_ARGS__ )
#else
#define DEBUG_MSG(...) 
#endif

void setup() {
    Serial.begin(115200);
	
	delay(3000);
	DEBUG_MSG("bootup...\n");
}

void loop() {
	DEBUG_MSG("loop %d\n", millis());
	delay(1000);
}
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Introduction

If the ESP crash the Exception Cause will be shown and the current stack will be dumped.

example:

Exception (0): epc1=0x402103f4 epc2=0x00000000 epc3=0x00000000 excvaddr=0x00000000 depc=0x00000000

ctx: sys 
sp: 3ffffc10 end: 3fffffb0 offset: 01a0

>>>stack>>>
3ffffdb0:  40223e00 3fff6f50 00000010 60000600  
3ffffdc0:  00000001 4021f774 3fffc250 4000050c  
3ffffdd0:  400043d5 00000030 00000016 ffffffff  
3ffffde0:  400044ab 3fffc718 3ffffed0 08000000  
3ffffdf0:  60000200 08000000 00000003 00000000  
3ffffe00:  0000ffff 00000001 04000002 003fd000  
3ffffe10:  3fff7188 000003fd 3fff2564 00000030  
3ffffe20:  40101709 00000008 00000008 00000020  
3ffffe30:  c1948db3 394c5e70 7f2060f2 c6ba0c87  
3ffffe40:  3fff7058 00000001 40238d41 3fff6ff0  
3ffffe50:  3fff6f50 00000010 60000600 00000020  
3ffffe60:  402301a8 3fff7098 3fff7014 40238c77  
3ffffe70:  4022fb6c 40230ebe 3fff1a5b 3fff6f00  
3ffffe80:  3ffffec8 00000010 40231061 3fff0f90  
3ffffe90:  3fff6848 3ffed0c0 60000600 3fff6ae0  
3ffffea0:  3fff0f90 3fff0f90 3fff6848 3fff6d40  
3ffffeb0:  3fff28e8 40101233 d634fe1a fffeffff  
3ffffec0:  00000001 00000000 4022d5d6 3fff6848  
3ffffed0:  00000002 4000410f 3fff2394 3fff6848  
3ffffee0:  3fffc718 40004a3c 000003fd 3fff7188  
3ffffef0:  3fffc718 40101510 00000378 3fff1a5b  
3fffff00:  000003fd 4021d2e7 00000378 000003ff  
3fffff10:  00001000 4021d37d 3fff2564 000003ff  
3fffff20:  000003fd 60000600 003fd000 3fff2564  
3fffff30:  ffffff00 55aa55aa 00000312 0000001c  
3fffff40:  0000001c 0000008a 0000006d 000003ff  
3fffff50:  4021d224 3ffecf90 00000000 3ffed0c0  
3fffff60:  00000001 4021c2e9 00000003 3fff1238  
3fffff70:  4021c071 3ffecf84 3ffecf30 0026a2b0  
3fffff80:  4021c0b6 3fffdab0 00000000 3fffdcb0  
3fffff90:  3ffecf40 3fffdab0 00000000 3fffdcc0  
3fffffa0:  40000f49 40000f49 3fffdab0 40000f49  
<<<stack<<<





the first number after Exception gives the cause of the reset.
a full ist of all causes can be found here
the hex after are the stack dump.


Decode

it’s possible to decode the Stack to readable information.
more info see Esp Exception Decoder [https://github.com/me-no-dev/EspExceptionDecoder] tool

[image: ../_images/ESP_Exception_Decoderp.png]ESP Exception Decoder







          

      

      

    

  

    
      
          
            
  
using Eclipse with Arduino ESP8266


What to Download


	arduino IDE [https://www.arduino.cc/en/Main/Software]


	Eclipse IDE for C/C++ Developers [http://www.eclipse.org/downloads/packages/eclipse-ide-cc-developers/marsr]


	Java [http://www.java.com/]







Setup Arduino

see the Readme [https://github.com/esp8266/Arduino#installing-with-boards-manager]




Setup Eclipse


	step 1 [http://www.baeyens.it/eclipse/how_to.shtml#/c]


	step 2 [http://www.baeyens.it/eclipse/how_to.shtml#/e]


	go to Window –> preferences –> Arduino


	add as private hardware path the Part to the ESP8266





example private hardware path

Windows: C:\Users\[username]\AppData\Roaming\Arduino15\packages\esp8266\hardware
Linux: /home/[username]/.arduino15/packages/esp8266/hardware










Eclipse wont build

if eclipse dont find the path to the Compiler add to the platform.txt
after:

version=1.6.4





this:

runtime.tools.xtensa-lx106-elf-gcc.path={runtime.platform.path}/../../../tools/xtensa-lx106-elf-gcc/1.20.0-26-gb404fb9
runtime.tools.esptool.path={runtime.platform.path}/../../../tools/esptool/0.4.4





Note:


	the path may changed, check the current version.


	each update over the Arduino IDE will remove the fix


	may not needed in future if Eclipse Plugin get an Update
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Introduction

OTA (Over the Air) update is the process of loading the firmware to ESP module using Wi-Fi connection rather that a serial port. Such functionality became extremely useful in case of limited or no physical access to the module.

OTA may be done using:


	Arduino IDE


	Web Browser


	HTTP Server




Arduino IDE option is intended primarily for software development phase. The two other options would be more useful after deployment, to provide module with application updates manually with a web browser or automatically using a http server.

In any case first firmware upload have to be done over a serial port. If OTA routines are correctly implemented in a sketch, then all subsequent uploads may be done over the air.

There is no imposed security on OTA process from being hacked. It is up to developer to ensure that updates are allowed only from legitimate / trusted source. Once update is complete, module restarts and new code is executed. Developer should ensure that application running on module is shut down and restarted in a safe manner. Chapters below provide additional information regarding security and safety of OTA process.


Security

Module has to be exposed wirelessly to get it updated with a new sketch. That poses chances of module being violently hacked and loaded with some other code. To reduce likelihood of being hacked consider protecting your uploads with a password, selecting certain OTA port, etc.

Check functionality provided with ArduinoOTA [https://github.com/esp8266/Arduino/tree/master/libraries/ArduinoOTA] library that may improve security:

void setPort(uint16_t port);
void setHostname(const char* hostname);
void setPassword(const char* password);





Certain protection functionality is already built in and do not require any additional coding by developer. ArduinoOTA [https://github.com/esp8266/Arduino/tree/master/libraries/ArduinoOTA] and espota.py use Digest-MD5 [https://en.wikipedia.org/wiki/Digest_access_authentication] to authenticate upload. Integrity of transferred data is verified on ESP side using MD5 [https://en.wikipedia.org/wiki/MD5] checksum.

Make your own risk analysis and depending on application decide what library functions to implement. If required consider implementation of other means of protection from being hacked, e.g. exposing module for uploads only according to specific schedule, trigger OTA only be user pressing dedicated “Update” button, etc.




Safety

OTA process takes ESP’s resources and bandwidth during upload. Then module is restarted and a new sketch executed. Analyse and test how it affects functionality of your existing and new sketch.

If ESP is placed in remote location and controlling some equipment, you should put additional attention what happens if operation of this equipment is suddenly interrupted by update process. Therefore decide how to put this equipment into safe state before starting the update.  For instance your module may be controlling a garden watering system in a sequence. If this sequence is not properly shut down and a water valve left open, your garden may be flooded if this valve is not closed after OTA is finished and module restarts.

The following functions are provided with ArduinoOTA [https://github.com/esp8266/Arduino/tree/master/libraries/ArduinoOTA] library and intended to handle functionality of your application during specific stages of OTA or on an OTA error:

void onStart(OTA_CALLBACK(fn));
void onEnd(OTA_CALLBACK(fn));
void onProgress(OTA_CALLBACK_PROGRESS(fn));
void onError(OTA_CALLBACK_ERROR (fn));








Basic Requirements

Flash chip size needs a size that is able to hold the old sketch (currently running) and the new sketch (OTA) at the same time.
Keep in mind that the File system and EEPROM for example needs space too (one time) see flash layout.

ESP.getFreeSketchSpace();





can be used for checking the free space for the new sketch.

For overview of memory layout, where new sketch is stored and how it is copied during OTA process see Update process - memory view.

The following chapters provide more details and specific methods of doing OTA.






Arduino IDE

Uploading modules wirelessly from Arduino IDE is intended for the following typical scenarios:


	during firmware development as a quicker alternative to loading over a serial


	for updating small quantity of modules


	only if modules are available on the same network as the computer with Arduino IDE





Requirements


	The ESP and the computer must be connected to the same network.







Application Example

Instructions below show configuration of OTA on NodeMCU 1.0 (ESP-12E Module) board. You can use any other board assuming that it meets requirements described above. This instruction is valid for all operating systems supported by Arduino IDE. Screen captures have been made on Windows 7 and you may see small differences (like name of serial port) if you are using Linux and MacOS.


	Before you begin, please make sure that you have the following s/w installed:


	Arduino IDE 1.6.7 or newer - https://www.arduino.cc/en/Main/Software


	esp8266/Arduino platform package 2.0.0 or newer - for instructions follow https://github.com/esp8266/Arduino#installing-with-boards-manager


	Python 2.7 (do not install Python 3.5 that is not supported) - https://www.python.org/

Note: Windows users should select “Add python.exe to Path” (see below – this option is not selected by default).

[image: ../_images/a-ota-python-configuration.png]Python installation set up







	Now prepare the sketch and configuration for the upload over a serial port.


	Start Arduino IDE and load sketch BasicOTA.ino available under File >  Examples > ArduinoOTA
[image: ../_images/a-ota-sketch-selection.png]selection of example OTA sketch


	Update SSID and password in the sketch so the module can join your Wi-Fi network
[image: ../_images/a-ota-ssid-pass-entry.png]SSID and password entry


	Configure upload parameters as below (you may need to adjust configuration if you are using a different module):
[image: ../_images/a-ota-serial-upload-configuration.png]configuration of serial upload

Note: Depending on version of platform package and board you have, you may see Upload Using: in the menu above. This option is inactive and it does not matter what you select. It has been left for compatibility with older implementation of OTA and is targeted for removal in platform package version 2.2.0.







	Upload the sketch (Ctrl+U). Once done, open Serial Monitor (Ctrl+Shift+M) and check if module has joined your Wi-Fi network:

[image: ../_images/a-ota-upload-complete-and-joined-wifi.png]check if module joined network



	Only if module is connected to network, after a couple of seconds, the esp8266-ota port will show up in Arduino IDE. Select port with IP adress shown in Serial Monitor in previus step:

[image: ../_images/a-ota-ota-port-selection.png]selection of OTA port

Note: If OTA port does not show up, exit Arduino IDE, open it again and check if port is there. If it does not help check your firewall settings.



	Now get ready for your first OTA upload by selecting the OTA port:

[image: ../_images/a-ota-ota-upload-configuration.png]configuration of OTA upload

Note: The menu entry  Upload Speed: does not matter at this point as it concerns the serial port. Just left it unchanged.



	If you have successfully completed all the above steps, you can upload (Ctrl+U) the same (or any other) sketch over OTA:

[image: ../_images/a-ota-ota-upload-complete.png]OTA upload complete





Note: To be able to upload your sketch over and over again using OTA, you need to embed OTA routines inside. Please use BasicOTA.ino as an example.


Password Protection

Protecting your OTA uploads with password is really straightforward. All you need to do, is to include the following statement in your code:

ArduinoOTA.setPassword((const char *)"123");





Where 123 is a sample password that you should replace with your own.

Before implementing it in your sketch, it is a good idea to check how it works using BasicOTA.ino sketch available under File > Examples > ArduinoOTA.  Go ahead, open BasicOTA.ino, uncomment the above statement that is already there, and upload the sketch. To make troubleshooting easier, do not modify example sketch besides what is absolutely required. This is including original simple 123 OTA password. Then attempt to upload sketch again (using OTA). After compilation is complete, once upload is about to begin, you should see prompt for password as follows:

[image: ../_images/a-ota-upload-password-prompt.png]Password prompt for OTA upload

Enter the password and upload should be initiated as usual with the only difference being Authenticating...OK message visible in upload log.

[image: ../_images/a-ota-upload-password-authenticating-ok.png] Authenticating...OK during OTA upload

You will not be prompted for a reentering the same password next time. Arduino IDE will remember it for you. You will see prompt for password only after reopening IDE, or if you change it in your sketch, upload the sketch and then try to upload it again.

Please note, it is possible to reveal password entered previously in Arduino IDE, if IDE has not been closed since last upload. This can be done by enabling Show verbose output during: upload in File > Preferences and attempting to upload the module.

[image: ../_images/a-ota-upload-password-passing-upload-ok.png]Verbose upload output with password passing in plan text

The picture above shows that the password is visible in log as it is passed to espota.py upload script.

Another example below shows situation when password is changed between uploads.

[image: ../_images/a-ota-upload-password-passing-again-upload-ok.png]Verbose output when OTA password has been changed between uploads

When uploading, Arduino IDE used previously entered password, so the upload failed and that has been clearly reported by IDE. Only then IDE prompted for a new password. That was entered correctly and second attempt to upload has been successful.




Troubleshooting

If OTA update fails, first step is to check for error messages that may be shown in upload window of Arduino IDE. If this is not providing any useful hints try to upload again while checking what is shown by ESP on serial port. Serial Monitor from IDE will not be useful in that case. When attempting to open it, you will likely see the following:

[image: ../_images/a-ota-network-terminal.png]Arduino IDE network terminal window

This window is for Arduino Yún and not yet implemented for esp8266/Arduino. It shows up because IDE is attempting to open Serial Monitor using network port you have selected for OTA upload.

Instead you need an external serial monitor. If you are a Windows user check out Termite [http://www.compuphase.com/software_termite.htm]. This is handy, slick and simple RS232 terminal that does not impose RTS or DTR flow control. Such flow control may cause issues if you are using respective lines to toggle GPIO0 and RESET pins on ESP for upload.

Select COM port and baud rate on external terminal program as if you were using Arduino Serial Monitor. Please see typical settings for Termite [http://www.compuphase.com/software_termite.htm] below:

[image: ../_images/termite-configuration.png]Termite settings

Then run OTA from IDE and look what is displayed on terminal. Successful ArduinoOTA process using BasicOTA.ino sketch looks like below (IP address depends on your network configuration):

[image: ../_images/a-ota-external-serial-terminal-output.png]OTA upload successful - output on an external serial terminal

If upload fails you will likely see errors caught by the uploader, exception and the stack dump, or both.

The most common causes of OTA failure are as follows:


	not enough physical memory on the chip (e.g. ESP01 with 512K flash memory is not enough for OTA),


	too much memory declared for SPIFFS so new sketch will not fit between existing sketch and SPIFFS – see  Update process - memory view,


	too little memory declared in Arduino IDE for your selected board (i.e. less than physical size).




For more details regarding flash memory layout please check File system [https://github.com/esp8266/Arduino/blob/master/doc/filesystem].
For overview where new sketch is stored, how it is copied and how memory is organized for the purpose of OTA see Update process - memory view.








Web Browser

Updates described in this chapter are done with a web browser that can be useful in the following typical scenarios:


	after application deployment if loading directly from Arduino IDE is inconvenient or not possible


	after deployment if user is unable to expose module for OTA from external update server


	to provide updates after deployment to small quantity of modules when setting an update server is not practicable





Requirements


	The ESP and the computer must be connected to the same network.







Implementation Overview

Updates with a web browser are implemented using ESP8266HTTPUpdateServer class together with ESP8266WebServer and ESP8266mDNS classes. The following code is required to get it work:

setup()

	MDNS.begin(host);

	httpUpdater.setup(&httpServer);
	httpServer.begin();

	MDNS.addService("http", "tcp", 80);





loop()

	httpServer.handleClient();








Application Example

The sample implementation provided below has been done using:


	example sketch WebUpdater.ino available in ESP8266HTTPUpdateServer library


	NodeMCU 1.0 (ESP-12E Module)




You can use another module if it meets previously desribed requirements.


	Before you begin, please make sure that you have the following software installed:


	Arduino IDE and 2.0.0-rc1 (of Nov 17, 2015) version of platform package as described under https://github.com/esp8266/Arduino#installing-with-boards-manager


	Host software depending on O/S you use:


	Avahi http://avahi.org/ for Linux


	Bonjour http://www.apple.com/support/bonjour/ for Windows


	Mac OSX and iOS - support is already built in / no any extra s/w is required










	Prepare the sketch and configuration for initial upload with a serial port.


	Start Arduino IDE and load sketch WebUpdater.ino available under File > Examples > ESP8266HTTPUpdateServer.


	Update SSID and password in the sketch so the module can join your Wi-Fi network.


	Open File > Preferences, look for “Show verbose output during:” and check out “compilation” option.

[image: ../_images/ota-web-show-verbose-compilation.png]Preferences - enabling verbose output during compilation

Note: This setting will be required in step 5 below. You can uncheck this setting afterwards.







	Upload sketch (Ctrl+U). Once done open Serial Monitor (Ctrl+Shift+M) and check if you see the following message displayed, that contains url for OTA update.

[image: ../_images/ota-web-serial-monitor-ready.png]Serial Monitor - after first load using serial

Note: Such message will be shown only after module successfully joins network and is ready for an OTA upload.



	Now open web browser and enter the url provided on Serial Monitor, i.e. http://esp8266-webupdate.local/update. Once entered, browser should display a form like below that has been served by your module. The form invites you to choose a file for update.

[image: ../_images/ota-web-browser-form.png]OTA update form in web browser

Note: If entering http://esp8266-webupdate.local/update does not work, try replacing esp8266-webupdate with module’s IP address. For example, if your module IP is 192.168.1.100 then url should be http://192.168.1.100/update. This workaround is useful in case the host software installed in step 2 does not work. If still nothing works and there are no clues on Serial Monitor, try to diagnose issue by opening provided url in Google Chrome, pressing F12 and checking contents of “Console” and “Network” tabs. Chrome provides some advanced logging on these tabs.



	To obtain the file navigate to directory used by Arduino IDE to store results of compilation. You can check the path to this file in compilation log shown in IDE debug window as marked below.

[image: ../_images/ota-web-path-to-binary.png]Compilation complete - path to binary file



	Now press “Choose File” in web browser, go to directory identified in step 5 above, find the file “WebUpdater.cpp.bin” and upload it. If upload is successful you will see “OK” on web browser like below.

[image: ../_images/ota-web-browser-form-ok.png]OTA update complete

Module will reboot that should be visible on Serial Monitor:

[image: ../_images/ota-web-serial-monitor-reboot.png]Serial Monitor - after OTA update

Just after reboot you should see exactly the same message HTTPUpdateServer ready! Open http:// esp8266-webupdate.local /update in your browser like in step 3. This is because module has been loaded again with the same code – first using serial port, and then using OTA.





Once you are comfortable with this procedure go ahead and modify WebUpdater.ino sketch to print some additional messages, compile it, locate new binary file and upload it using web browser to see entered changes on a Serial Monitor.

You can also add OTA routines to your own sketch following guidelines in Implementation Overview above. If this is done correctly you should be always able to upload new sketch over the previous one using a web browser.

In case OTA update fails dead after entering modifications in your sketch, you can always recover module by loading it over a serial port. Then diagnose the issue with sketch using Serial Monitor. Once the issue is fixed try OTA again.






HTTP Server

ESPhttpUpdate class can check for updates and download a binary file from HTTP web server.
It is possible to download updates from every IP or domain address on the network or Internet.


Requirements


	web server







Arduino code


Simple updater

Simple updater downloads the file every time the function is called.

ESPhttpUpdate.update("192.168.0.2", 80, "/arduino.bin");








Advanced updater

Its possible to point update function to a script at the server.
If version string argument is given, it will be sent to the server.
Server side script can use this to check if update should be performed.

Server side script can respond as follows:


	response code 200, and send the firmware image,


	or response code 304 to notify ESP that no update is required.




t_httpUpdate_return ret = ESPhttpUpdate.update("192.168.0.2", 80, "/esp/update/arduino.php", "optional current version string here");
switch(ret) {
	case HTTP_UPDATE_FAILED:
		Serial.println("[update] Update failed.");
		break;
	case HTTP_UPDATE_NO_UPDATES:
		Serial.println("[update] Update no Update.");
		break;
	case HTTP_UPDATE_OK:
		Serial.println("[update] Update ok."); // may not called we reboot the ESP
		break;
}










Server request handling


Simple updater

For the simple updater the server only needs to deliver the binary file for update.




Advanced updater

For advanced update management a script needs to run at the server side, for example a PHP script.
At every update request the ESP sends some information in HTTP headers to the server.

Example header data:

	[HTTP_USER_AGENT] => ESP8266-http-Update
    [HTTP_X_ESP8266_STA_MAC] => 18:FE:AA:AA:AA:AA
    [HTTP_X_ESP8266_AP_MAC] => 1A:FE:AA:AA:AA:AA
    [HTTP_X_ESP8266_FREE_SPACE] => 671744
    [HTTP_X_ESP8266_SKETCH_SIZE] => 373940
    [HTTP_X_ESP8266_CHIP_SIZE] => 4194304
    [HTTP_X_ESP8266_SDK_VERSION] => 1.3.0
    [HTTP_X_ESP8266_VERSION] => DOOR-7-g14f53a19





With this information the script now can check if an update is needed. It is also possible to deliver different binaries based on the MAC address for example.

Script example:

<?PHP

header('Content-type: text/plain; charset=utf8', true);

function check_header($name, $value = false) {
	if(!isset($_SERVER[$name])) {
		return false;
	}
	if($value && $_SERVER[$name] != $value) {
		return false;
	}
	return true;
}

function sendFile($path) {
	header($_SERVER["SERVER_PROTOCOL"].' 200 OK', true, 200);
	header('Content-Type: application/octet-stream', true);
	header('Content-Disposition: attachment; filename='.basename($path));
	header('Content-Length: '.filesize($path), true);
	header('x-MD5: '.md5_file($path), true);
	readfile($path);
}

if(!check_header('HTTP_USER_AGENT', 'ESP8266-http-Update')) {
	header($_SERVER["SERVER_PROTOCOL"].' 403 Forbidden', true, 403);
	echo "only for ESP8266 updater!\n";
	exit();
}

if(
	!check_header('HTTP_X_ESP8266_STA_MAC') ||
	!check_header('HTTP_X_ESP8266_AP_MAC') ||
	!check_header('HTTP_X_ESP8266_FREE_SPACE') ||
	!check_header('HTTP_X_ESP8266_SKETCH_SIZE') ||
	!check_header('HTTP_X_ESP8266_CHIP_SIZE') ||
	!check_header('HTTP_X_ESP8266_SDK_VERSION') ||
	!check_header('HTTP_X_ESP8266_VERSION')
) {
	header($_SERVER["SERVER_PROTOCOL"].' 403 Forbidden', true, 403);
	echo "only for ESP8266 updater! (header)\n";
	exit();
}

$db = array(
	"18:FE:AA:AA:AA:AA" => "DOOR-7-g14f53a19",
	"18:FE:AA:AA:AA:BB" => "TEMP-1.0.0"
);

if(isset($db[$_SERVER['HTTP_X_ESP8266_STA_MAC']])) {
	if($db[$_SERVER['HTTP_X_ESP8266_STA_MAC']] != $_SERVER['HTTP_X_ESP8266_VERSION']) {
		sendFile("./bin/".$db[$_SERVER['HTTP_X_ESP8266_STA_MAC']]."bin");
	} else {
		header($_SERVER["SERVER_PROTOCOL"].' 304 Not Modified', true, 304);
	}
	exit();
}

header($_SERVER["SERVER_PROTOCOL"].' 500 no version for ESP MAC', true, 500);












Stream Interface

TODO describe Stream Interface

The Stream Interface is the base for all other update modes like OTA, http Server / client.




Updater class

Updater is in the Core and deals with writing the firmware to the flash,
checking its integrity and telling the bootloader to load the new firmware on the next boot.


Update process - memory view


	The new sketch will be stored in the space between the old sketch and the spiff.


	on the next reboot the “eboot” bootloader check for commands.


	the new sketch is now copied “over” the old one.


	the new sketch is started.




[image: ../_images/update_memory_copy.png]Memory Copy
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#define RFMIZB_NETWORK_ID 100

Debug Level: "None"
* ssid - [ Reset Method: “nodemcu”

* password =

Flash Frequency: "80MHz' Decoding 9 results.

//ADC_MODE(ADC_TOUTY; Upload Using: "Serial* 0x402 1 tec7- tep. nput at 722
Ssb1306 disploy CPU Frequency: "160 MHz" 0x4021bee2: ip_input at 727
Brewire dscity; Upload Speed: "115200" 0x4021baf 1 ipaddr_aton at 727

0x402 1bae0: ipaddr_aton at 77:7
0x4021a8f6: dns_tmr at 727

/devjcu.usbserial-A5028581"

Y YYYYYYVYVYVVYY

ds_oder(8]; 0x4021968b: dhcp_stop at 77:7
ds_data[12]; 0x40219¢36: node_remove_from_list at 72:7
typedef cnum { DS_IDLE, DS_START, DS} 0x402255ef: aes_wrap at 777

o.state t ds_state - S TOLE; 0x40205bdb: MDNSResponder::addserviceTxt(char*, char*, char®, char) at

/Users [ficeto/ Desktop/ESP8266/ Arduino-Main/ build/macosx /work  Arduino.app/ Contents /Java/ hardware/esp8
Decodte Success 266com/esp8266/libraries /ESP8266mDNS/ESP8266mDNS.cpp: 181

Library SPI at version 1
Library Wire at version 1
Library SSD1306 in fold

Library RFMIZE_ESP in fol

Library Onelfire in fold

Library ESPs
1 lcafaro synchronize #151

1 lcafaro synchronize #151

mcu, Dis ® DualitvaY closed #1517
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